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Welcome to the ServSwitch™ Family!
Thank you for purchasing a BLACK BOX® ServSelect IP! We appreciate your 
business, and we think you’ll appreciate the many ways that your new ServSelect IP 
will save you money, time, and effort.

That’s because our ServSwitch family is all about breaking away from the traditional, 
expensive model of computer management. You know, the one-sizefits-all-even-if-it-
doesn’t model that says, “One computer gets one user station, no more, no less.” Why 
not a single user station (monitor, keyboard, and mouse) for multiple computers—even 
computers of different platforms? Why not a pair of user stations, each of which can 
control multiple computers? Why not multiple user stations for the same computer?

With our ServSwitch products, there’s no reason why not. We carry a broad line of 
robust solutions for all these applications. Do you have just two PCs, and need an 
economical alternative to keeping two monitors, keyboards, and mice on your desk? 
Or do you need to share dozens of computers, including a mix of IBM® PC, 
RS/6000®, Apple® Macintosh®, Sun Microsystems®, and SGI™ compatibles 
among multiple users with different access levels? Does your switch have to sit 
solidly on a worktable and use regular everyday cables? Or does it have to be 
mounted in an equipment rack and use convenient many-to-one cables? No matter 
how large or small your setup is, no matter how simple or how complex, we’re 
confident we have a ServSwitch system that’s just right for you.

The ServSwitch™ family from Black Box—the one-stop answer for all your KVM 
switching needs!

*
This manual will tell you all about your new ServSelect IP software, including how to 
install, operate, and troubleshoot it. For an introduction to the ServSelect IP software, 
see Chapter 1. The ServSelect IP product codes covered in this manual are:

KV120     KV121
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TRADEMARKS USED IN THIS MANUAL

BLACK BOX and the  logo are registered trademarks, and ServSwitch, 
ServSelect, and ServSelect IP are trademarks, of BLACK BOX Corporation.

Apple, Mac, and Macintosh are registered trademarks of Apple Computer, Inc.

IBM, PS/2, and RS/6000 are registered trademarks of International Business 
Machines Corporation.

Microsoft, HyperTerminal, Windows, Windows NT, and Windows XP are 
trademarks or registered trademarks of Microsoft Corporation in the United States 
and/or other countries.

Sun and Sun Microsystems are registered trademarks of Sun Microsystems, Inc. in 
the United States and other countries.

Any other trademarks mentioned in this manual are acknowledged to be the property 
of the trademark owners.
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1. Introduction

1.1 About ServSelect IP Software
ServSelect IP Software is a cross-platform management application that allows you 
to view and control the ServSelect IP appliance and all its target servers. The cross-
platform design ensures compatibility with most popular operating systems and 
hardware platforms. ServSelect IP provides secure switch-based authentication, data 
transfers and username/password storage. Each appliance handles authentication and 
access control individually, placing system control at the point of need. 

ServSelect IP Software utilizes browser-like navigation with an intuitive split-screen 
interface, providing you with a single point of access for all your servers. Using 
ServSelect IP Software, you can manage your existing appliances, install a new 
switch or launch a video session to a target server. Built-in groupings such as 
Servers, Sites and Folders provide an easy way to select the units to view. Powerful 
search and sort capabilities allow you to easily find any unit. 

NOTE: 
Throughout the documentation and ServSelect IP Software user interface, you will see the word 
“appliance” used generically to describe the ServSelect IP switch.

1.2 Features and Benefits
Easy to install and configure
ServSelect IP Software is designed for easy installation and operation. Auto-discovery of 
managed appliances enables you to deploy new units in minutes. Wizard-based 
installation and online help simplify initial system configuration. The intuitive graphical 
interface makes managing and updating appliances simple and straightforward.

Powerful customization capabilities
Tailor ServSelect IP Software to fit your specific system needs. Take advantage of 
built-in groups or create your own. Customize unit and field names, icons and 
macros for maximum flexibility and convenience. Using names that are meaningful 
to you makes it easy to quickly find any target server.

Extensive ServSelect IP management
ServSelect IP Software allows you to add and manage multiple appliances in one 
system. Once a new appliance is installed, you can configure switch parameters, 
control and preempt user video sessions and execute numerous control functions, such 
as rebooting and upgrading your appliance. From the intuitive Appliance Management 
Panel (AMP), you can enable Simple Network Management Protocol (SNMP) traps, 
configure target servers and cascade switches as well as manage user databases.
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2. Installation

2.1 Getting Started
Before installing your ServSelect IP Software, refer to the following lists to ensure 
that you have all the items that shipped with your software as well as all other items 
necessary for proper installation.

Supplied with ServSelect IP Software
Your ServSelect IP Software package contains the following items:

• ServSelect IP Software CD

• ServSelect IP Software Installer/User Guide

Supported operating systems
ServSelect IP Software is supported on the following operating systems:

• Microsoft® Windows® 2000 Workstation - Service Pack 2

• Microsoft Windows 2000 Server - Service Pack 2

• Microsoft Windows NT® 4.0 Workstation - Service Pack 6a 

• Microsoft Windows NT 4.0 Server - Service Pack 6a  

• Microsoft Windows XP® (Home and Professional)

• Red Hat® Linux® 7.1 (2.7 Kernel)

• Red Hat Linux 7.2 (2.7 Kernel)

PC hardware configuration requirements
The following list contains the PC hardware configuration requirements for running 
ServSelect IP Software on the supported operating systems. Configurations with less 
than the recommended requirements are not supported.

• 500 MHz Pentium® III 

• 128 MB RAM

• 10 or 100BASE-T NIC 

• VGA or XGA video with graphics accelerator

• Desktop size must be a minimum of 800 x 600

• Color palette must be a minimum of 256 colors
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2.2 Installing ServSelect IP Software 
ServSelect IP Software can be installed on Microsoft Windows NT, Windows 2000, 
Windows XP and Linux platforms. Follow these instructions to install ServSelect IP 
Software on the desired platform. 

To install on Microsoft Windows NT, 2000 or XP:
1. Insert the ServSelect IP Software CD-ROM into your CD-ROM drive. If 

AutoPlay is supported and enabled, the setup program will start automatically.
-or-
If your system does not support AutoPlay, set the default drive to your CD-
ROM drive letter and execute the following command to start the install 
program (replace drive with your CD-ROM drive letter):

 drive:\WIN32\SETUP.EXE

2. Follow the on-screen instructions.

To install on Red Hat Linux:
1. Insert the ServSelect IP Software CD-ROM into your CD-ROM drive. If 

AutoPlay is supported and enabled, the setup program will start automatically.
-or-
If your system does not support AutoPlay:
a. Mount the CD-ROM volume by executing the following command:

 mount –t iso9660 –ro mode=0555 <unit> <mount point>

 Replace <unit> with the name of the CD-ROM on your machine and 
<mount point> with the name of the desired mount point. For 
example, to mount a CD-ROM which is the second IDE unit on 
/mnt, execute the command:

 mount –t iso9660 –ro mode=0555 /dev/hdb /mnt

b. Execute the following command to change the working directory to the 
mount point:

 cd /mnt

c. Execute the following command to start the install program:
 sh./linux/setup.bin

2. Follow the on-screen instructions.
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3. Basic Operations

3.1 Launching ServSelect IP Software
To launch the software on all Microsoft Windows operating systems:

Select Start - Programs - Black Box ServSelect IP Software. 
-or-
Double-click the ServSelect IP Software icon. ServSelect IP Software will launch.

To launch the software on Red Hat Linux (7.1 and 7.2):

From the application folder (/usr/lib/Black Box_ServSelect_IP_Software/), execute 
the following command:
./Black_Box_ServSelect_IP_Software

-or-
From (/user/bin), execute the following link:
./Black_Box_ServSelect_IP_Software

-or-
If a desktop shortcut was created on installation, double-click the shortcut and then 
select Run. ServSelect IP Software will launch.

3.2 Navigating ServSelect IP Software
ServSelect IP Software consists of several components: the ServSelect IP Software 
Explorer, the Video Session Viewer (Viewer) and the Appliance Management Panel 
(AMP). Once you launch the ServSelect IP Software, the main ServSelect IP Software 
Explorer window appears. The Explorer window allows you to view, access, manage 
and create custom groupings for all of the supported units in your data center. 

When you select a target server, you can click the Connect Video task button in the 
ServSelect IP Software Explorer to launch the Viewer. This component allows you 
to control the keyboard, monitor and mouse functions of individual servers. For 
more information, see Accessing and Managing Your Servers in this chapter. 

When you select an appliance, you can click the Manage appliance task button in 
the ServSelect IP Software Explorer to launch the AMP. This component enables 
you to configure and control your appliance. For more information, see Chapter 4.

Viewing your system in the ServSelect IP Software Explorer
The ServSelect IP Software Explorer is divided into several panes: the View 
Selector tabs, the Group Selector pane and the Unit Selector pane. The content of 
these panes will change based on the type of unit selected or the task to be 
completed. Figure 3-1 highlights these navigation features.
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Click one of the View Selector tabs to view your system organized by categories: 
Appliances, Servers, Sites or Folders. The Explorer’s default display is user-
configurable. For more information, see Customizing the ServSelect IP Software 
Explorer Window in this chapter. The ServSelect IP Software Explorer default display 
is set for the Server view once you have added your first appliance.

NOTE: 
The Group Selector pane does not appear under the Appliances or Servers tab unless you have more 
than one type of appliance or server.

ServSelect IP Software Explorer Window Features

A

B

D

F

G

H

I

E

C

Figure 3-1. ServSelect IP Software Explorer Window

A. Menu bar: Allows you to access many of the features in ServSelect IP Software.

B. View Selector tabs: Used for choosing the ServSelect IP Software Explorer view.

C. Root node: Each tree consists of a root node and branches. 

D. Group Selector pane: Contains a tree view representing the groups that are 
available for the current View Selector tab. The selected group controls what 
is displayed in the Unit Selector pane when the Appliances, Servers, Sites or 
Folder tabs are selected.

E. Status bar: Displays the number of units shown in the Unit list.

F. Unit Selector pane: Contains the Search bar, Unit list and Task buttons 
appropriate for the selected view or group.

G. Search bar: Allows you to search the database for the text entered in the 
search box. 
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H. Unit list: Displays a list of appliances and selectable servers contained in the 
currently selected group, or the results of the search executed from the 
Search bar. 

I. Task buttons: Contains buttons representing tasks that can be executed. 
Some buttons are dynamic based on the type of unit(s) selected in the Unit 
list while other buttons are fixed and always present. 

3.3 Quick Setup Checklist
The following list is an overview of the steps you will follow to set up and configure your 
ServSelect IP system. Each of these steps is explained in detail in separate topics 
throughout this manual and the ServSelect IP Installer/User Guide.

To set up the ServSelect IP (see the ServSelect IP Installer/User Guide):
1. Adjust mouse acceleration on each server to Slow or None.
2. Install the ServSelect IP hardware, connect the SAM adapters and connect the 

keyboard, monitor and mouse to the analog port. 
3. Connect a terminal to the configuration port (labelled “1010”) on the back 

panel of the ServSelect IP and set up network configuration (set network speed 
and address type). The IP address can be set from ServSelect IP Software. 

4. Using the local analog workstation, input all server names via the On-Screen 
Display (OSD).

To set up ServSelect IP Software: 
1. Install ServSelect IP Software on each ServSelect IP Software client. 

2. From one ServSelect IP Software client, launch ServSelect IP Software. 
3. Click the New Appliance task button to add the new switch to the ServSelect IP 

Software database. The New Appliance Wizard appears. If you configured the 
IP address as described above, select Yes, the product already has an IP 
address, otherwise select No, the product does not have an IP address. 
ServSelect IP Software will find the appliance and all SAM adapters attached to 
it. These names will display in the ServSelect IP Software Explorer. 

4. Set properties and group servers as desired into locations, sites or folders 
through the ServSelect IP Software Explorer. 

5. Create user accounts through the AMP. 
6. Once one ServSelect IP Software client is set up, select File - Database - Save 

to save a copy of the database with all the settings. 
7. From the second ServSelect IP Software client, click File - Database - Load 

and browse to find the file you have saved. Select the file and click Load. 
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8. If the local analog workstation (via the OSD) adds, deletes or renames any 
SAM adapters after you have loaded this file, you can resynchronize your local 
database with the OSD by clicking the Manage Appliance task button and 
clicking the Resync button under Settings - Servers.

9. To access a server attached to your ServSelect IP, select the desired server in 
the ServSelect IP Software Explorer and click the Connect Video task button to 
launch a server session in the Video Session Viewer. 

10. Adjust the resolution (select View - Auto Scale) and quality (select Tools - 
Automatic Video Adjust) of the server video in the Video Session Viewer.

3.4 Adding an Appliance
Before you can access your appliance through ServSelect IP Software, you must add 
it to the ServSelect IP Software database. Once an appliance is added, it appears in 
the Unit list. You may either manually add or discover an appliance. 

To manually add an appliance that already has an assigned IP address:
1. Select File - New - Appliance from the ServSelect IP Software Explorer menu.

-or-
Click the New Appliance task button. The New Appliance Wizard appears. 
Click Next to continue.

2. Select the type of appliance you are adding. Click Next.

3. You are prompted to indicate whether the appliance has an assigned IP address 
or not. Click Yes and then click Next.

4. The Find ServSelect IP window appears. Type the IP address and click Next. 

Figure 3-2. Find ServSelect IP Dialog Box

5. The ServSelect IP Software will search for the indicated unit as well as all the 
powered SAMs and server names you associated with it in the OSD, if any. If you 
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want to search for unpowered SAMs, you can access the Resync feature under the 
Servers category in the AMP and click the Include Offline SAM adapters checkbox. 
For more information, see Viewing server connections in Chapter 4. Click Next.

6. The Configure Cascade Switches dialog box appears if the ServSelect IP 
Software detects an attached ServSwitch Multi Z8. This box contains a list of 
all SAM adapter EIDs (Electronic Identification Numbers) retrieved from the 
appliance and the Z8s to which they are connected, if any. When this dialog 
box first displays, all the switches will be set to None. Switches detected will 
have an icon next to the pulldown menu.
a. The Existing Cascade Switches field contains all the current Z8s defined 

in the database. Click Add, Delete or Modify to alter the list.
b. Associate the appropriate Z8 from the pulldown menus for each SAM that 

has a Z8 attached.

Figure 3-3. Configure Cascade Switches Dialog Box

7. When you reach the final page of the Wizard, click Finish to exit the Wizard 
and return to the main window. Your appliance should now appear in the Unit 
Selector pane.

To manually install an appliance with no currently assigned IP address:
1. Select File - New - ServSelect IP from the ServSelect IP Software Explorer menu.

-or-
Click the New Appliance task button. The New Appliance Wizard appears. 
Click Next to continue.

2. You are prompted to indicate if the ServSelect IP has an assigned IP address. 
Click No and then click Next.

3. The Network Address window appears. Type the IP address, subnet mask and 
gateway that you want to assign to the unit and click Next. 
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4. The Select ServSelect IP window appears, prompting you to select the unit to add 
from the list of appliances that were found. Select the unit and then click Next.

5. The Configuring ServSelect IP window indicates whether the IP information 
was successfully configured. If the configuration was successful, the ServSelect 
IP Software will search for the new appliance as well as all SAMs and server 
names associated with it. Click Next.

6. The Configure Cascade Switches dialog box appears if the ServSelect IP 
Software detects an attached Z8. This box contains a list of all SAM adapter EIDs 
retrieved from the appliance and the Z8s to which they are connected, if any. 
a. The Existing Cascade Switches field contains a list of all the current Z8s 

defined in the database. You may add, delete or modify the list.
b. Associate the appropriate Z8 from the pulldown menus for each SAM that 

has a Z8 attached.

Figure 3-4. Configure Cascade Switches Dialog Box

7. When complete, click Finish to exit the Wizard and return to the main window. Your 
appliance should now appear in the Unit Selector pane.

To discover an appliance by IP address:
1. Select Tools - Discover from the ServSelect IP Software Explorer menu. The 

Discover Wizard appears. Click Next to continue.

2. The Address Range page appears. Type the range of IP addresses to search on 
the network in the To and From boxes. Use the IP address dot notation 
xxx.xxx.xxx.xxx. Click Next to continue.

(continued on the next page)
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3. The Searching Network progress bar appears. If one or more new appliances are 
discovered, the Wizard shows the Select Appliances to Add page. From this page, 
you can choose the appliances to add to the local database.
-or-
If no new appliances were found (or if you clicked Stop), the Wizard will show 
the No New Appliances Found page and you will need to add the switch 
manually. For more information, see the previous procedures.

4. Click on an appliance to add and click the Add (>) icon to move the selection to 
the Appliances to Add list.

5. Repeat step 4 for all appliances you wish to add. Click Next to continue.

6. The Adding Appliances progress bar appears while the new switches are being 
added. Once all of the switches have been added to the local database, the Discover 
Wizard Completed page appears. Click Finish to exit the Wizard and return to the 
main window. Your new switch should now be in the Unit Selector pane. 

 The Discover Wizard will not automatically find servers attached to the appliance. 
After running the Discover Wizard, you must click the Resync button in the AMP to 
find servers attached to the appliance. For more information, see Resynchronizing the 
server listing in Chapter 4.
-or-
If one or more appliances could not be added to the local database for any 
reason (including if you clicked Stop during the add process), the Discover 
Wizard Not All Appliances Added page appears. This page will list all of the 
appliances that you selected and the status for each. The status will indicate 
whether an appliance was added to the local database and if not, why the 
process failed. Click Done when you are finished reviewing the list.

NOTE: 
If an appliance already exists in the database with the same IP address as a discovered unit, then 
the discovered unit will be ignored and will not display on the next Wizard page.

3.5 Accessing an Appliance 
When you click the Appliances button, you will see a list of the appliances currently 
defined in the local database. To access an appliance, you must first log into it by 
typing in a username and password. Once you have logged into an appliance, 
ServSelect IP Software will cache the username and password in memory for the 
duration of the ServSelect IP Software session. 

NOTE: 
You can clear the login credentials by selecting Tools - Clear Login Credentials.
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Figure 3-5. Appliance View Tab Selected

To log into an appliance:
1. Click the Appliances button in the ServSelect IP Software Explorer.

2. Double-click on an appliance from the Unit Selector pane.
-or-
Select an appliance, and then click the Manage appliance task button.
-or-
Right-click an appliance. A pop-up menu appears. Select Manage appliance.
-or-
Click an appliance in the Unit Selector pane and press Enter. 

3. A password prompt appears. Type in your username and password. The default 
username is Admin with no password.

NOTE:
 If you previously logged into the appliance during the same ServSelect IP Software session, the 
password prompt will not appear.

4. Click OK to access the appliance. This launches the AMP. For more 
information about the AMP, see Chapter 4.
-or-
Click Cancel to exit without logging in.
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3.6 Accessing and Managing Your Servers
The Servers tab displays a list of servers defined in the database. The Group Selector 
pane appears if two or more server types are defined. Click All Servers or click on a 
folder to view all servers of a particular type. When you select a server and click the 
Connect Video task button, the Viewer launches. The Viewer allows you full 
keyboard, monitor and mouse control over a server. 

Figure 3-6. Servers View Tab Selected

To access a server:
1. Click the Servers tab in the ServSelect IP Software Explorer. 

2. Double-click on the server from the Unit Selector pane. 
-or-
Select a server, and then click the Connect Video task button. 
-or-
Right-click on the server. A pop-up menu appears. Select Connect Video.
-or-
Click a server in the Unit Selector pane and press Enter. The Viewer launches 
in a new window.

To search for a server in the local database:
1. Click the Servers tab and insert your cursor in the Search text box.

2. Type the search information. This can be a server name or property (type, site, 
location or folder).
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3. Click the Search button. The results appear in the Unit list.

4. Review the results of your search. Click the Clear Results button if you want to 
display the entire list again.

To auto search by typing in the Unit list:
1. Click the Servers tab, then click on any item in the Unit list.

2. Type the first few characters of a server name. The highlight moves to the first 
server name beginning with those characters. To reset the search to find another 
server, pause for a few seconds and then type the first few characters of that name.

Interacting with the server being viewed
Once you have connected to a server, the server’s desktop appears in a separate window 
called the Video Session Viewer. You see two cursors, the local system’s as well the 
server’s cursor. You may need to align these if they do not move together. See Aligning 
the mouse or resetting the PS/2 connection in this chapter. 

From this window, you will be able to access all the normal functions of this server 
as if you were sitting in front of it. You may also perform Viewer-specific tasks 
such as sending special Macro commands to the server.

Viewer Window Features

A

B

C

E
D

Figure 3-7. Video Viewer Window

A. Menu bar: Access many of the features in the Viewer.

B. Accessed server desktop: Interact with your server through this window.

C. Full Screen button: Expand the accessed server desktop to fill the entire screen.

D. Refresh Video button: Regenerate the digitized video image of the server desktop.

E. Align Local Cursor button: Re-establish proper tracking of the local cursor 
to the remote server cursor.
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Expanding and refreshing your Video Viewer
You can adjust your view using the three buttons at the top of the Video Viewer 
window. The first button allows you to align the mouse cursors, the second is to 
refresh the video and the third allows you to expand the Video Viewer window to 
encompass the entire screen. If you choose to expand the Video Viewer window, the 
menu bar will disappear, but you will still see a small floating palette with these 
three buttons and the Macros pulldown menu. 

Figure 3-8. Full Screen Toolbar

To align the mouse cursors:

Click the Align Local Cursor button on the Viewer toolbar. The local cursor will 
align with the cursor on the remote server.

To refresh the screen: 

Click the Refresh Image button on the Viewer toolbar. 
-or-
From the Viewer menu, select View - Refresh. The digitized video image will be 
completely regenerated.

To enter full screen mode:

Click the Full Screen Mode button. 
-or-
From the Viewer menu, select View - Full Screen. The desktop window will disappear 
and only the accessed server desktop will be visible. The screen will be resized up to a 
maximum of 1024 x 768. If the desktop has a higher resolution, then a black 
background will surround the full screen image. The floating toolbar will appear.

To exit full screen mode:

Click the Full Screen Mode button on the floating toolbar to exit full screen mode 
and return to the desktop window.

Adjusting the Video Viewer window
You can adjust both the resolution and quality of the Video Viewer. You can also 
expand your session to fit the entire screen or refresh the view at any time. 
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Adjusting the window size
The Video Viewer allows you to set up automatic or manual scaling of the session 
image. When Auto Scale is selected, the desktop window remains fixed and the server 
image is scaled to fit the window. When Manual Scale is selected, a drop-down menu 
of supported image scaling resolutions is displayed. 

To adjust the size of the Video Viewer window:

From the menu, select View - Auto Scale to scale the server image automatically.
-or-
From the menu, select View - Manual Scale, then choose the dimension to scale 
the window.

Figure 3-9. Viewer Manual Scale

Adjusting the video quality
The Video Viewer offers both automatic and manual video adjustment capability. 
Generally, the Automatic Video Adjustment will optimize the video for the best 
possible view. However, you may fine tune the video with the aid of Black Box 
technical support. See Appendix D: Troubleshooting. Video adjustment is a global 
setting and applies to each target server you access. 

Adjusting mouse settings
The Video Viewer allows you to select among five different mouse cursor options, 
set up mouse scaling and resynchronize your mouse should it no longer track 
properly. Mouse settings are target-server-specific and can be set differently for each 
server. These setting are placed into the local client database and applied each time 
you launch a session to a specific server. 
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Figure 3-10. Viewer Mouse Session Options Dialog Box

Setting mouse scaling
You can choose among three preconfigured mouse scaling options or set your own 
custom scaling. The preconfigured settings are: Default (1:1), High (2:1) or Low (1:2). 
In a 1:1 scaling ratio, every mouse movement on the desktop window will send an 
equivalent mouse movement to the server. In a 2:1 scaling, the same mouse movement 
will send a 2X mouse movement. In a 1:2 scaling, the value will be 1/2X. 

To set custom mouse scaling:
1. Select Tools - Session Options. The Session Options dialog box appears.

2. Click the Mouse tab.

3. Click the Custom radio button. The X and Y fields become enabled.

4. Type a mouse scaling value in the X and Y fields. For every mouse input, the 
mouse movements are multiplied by the respective X and Y scaling factors. 
Valid input ranges are 0.25 to 3.00.

Aligning the mouse or resetting the PS/2 connection
If you find that your mouse or keyboard no longer responds properly, you can align 
the mouse to re-establish proper tracking or reset the PS/2 connection (if you are 
controlling a server with PS/2 keyboard and mouse ports). Resetting the PS/2 
connection causes the appliance to simulate a mouse and keyboard reconnect at the 
server as if you had disconnected and then reconnected them. Alignment causes the 
local cursor to be aligned with the cursor on the remote server.

NOTE: 
If the server does not support the ability to disconnect and reconnect the mouse (almost all newer 
PCs do), then the mouse will become disabled and the server will have to be rebooted.
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To realign the mouse:

Click the Align Local Cursor button on the Viewer toolbar.

To reset the PS/2 connection:
1. Select Tools - Session Options in the Viewer. The Session Options dialog box appears.

2. Click the Mouse tab.

3. Click the Reset PS/2 button. A dialog box appears prompting you to confirm. 

4. Click the Reset PS/2 Connection at the Server checkbox and click OK.

Using macros to send keystrokes to a server 
The Macros menu in the Video Viewer allows you an easy way to send multiple 
keystrokes to the server or to send keystrokes that you cannot generate without 
affecting your local system, such as Control-Alt-Delete. The Viewer provides a 
list of default keystroke selections; however, you may set up your own macros, as 
well as change the set that displays by default, by selecting the Configure option at 
the bottom of the Macros pulldown menu. 

Figure 3-11. Viewer Macro Menu Expanded

Sending keystrokes to a server

Select the Macros menu in the Viewer and choose the macro to send to the server. 
Figure 3-11 shows the default macros that ship with ServSelect IP Software. If you 
do not see the keystroke you need, select Configure to access the Macros dialog box. 
Here you can create, modify, delete and group macros. 

Macro Groups settings are specific to each target server and, therefore, can be set 
differently for each server. These settings are placed into the local client database 
and applied each time you launch a session to a specific server. 
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To change the default Macro group:
1. Select Tools - Session Options in the Viewer. The Session Options dialog box appears.

2. Click the Macros tab.

Figure 3-12. Viewer Session Options Dialog Box - Macro Tab

3. Select a macro group from the pulldown list to appear in the Macro menu and 
click OK.

Creating new macros
You can create custom macro keystrokes as well as modify and delete existing 
macros through the Macros dialog box.

To create a new macro:
1. Select Macros - Configure from the Viewer. The Macros dialog box appears.

Figure 3-13. Viewer Macro Dialog Box

2. Click Create. The Create/Edit Macros dialog box appears.
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Figure 3-14. Viewer Create/Edit Macro Dialog Box

3. Type the name of the macro in the Macro Name field.

4. Select the desired category and keystrokes from the list of Available Keystrokes 
and click Add.
-or-
Type the keystrokes to send in the Keystrokes field.

5. Click OK to accept the macro and return to the Macros dialog box.
-or-
Click Reset to erase all the keystrokes entered in the Keystrokes field.

Grouping macros
The Macro Groups dialog box allows you to arrange macros into logical groups. 
Macro groups for Windows and Sun are already predefined; you can alter either of 
these two groups or create an entirely new group. You can also rename and delete 
groups that have been previously created.

To create a macro group:
1. Select Macros - Configure from the Viewer. The Macros dialog box appears.

2. Click Group. The Macro Groups dialog box appears. The Macros Available box 
contains macros that are not currently in use by this group.
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Figure 3-15. Viewer Macro Groups Dialog Box

3. Click Create. A dialog box appears prompting you to name the new macro group. 

4. Type in a name. Click OK to save the name and return to the Macro Groups 
dialog box. A tab with the new name appears.

To add macros to an existing group:
1. Select Macros - Configure from the Viewer. The Macros dialog box appears.

2. Click Group. The Macro Groups dialog box appears.

3. Click the macro group tab to alter. Windows and Sun are the default tabs. If you 
have created a new group, you will see a tab for this group as well. 

4. Click on the macro to add from the Macros Available pane on the left side of 
the dialog box. Click the Add button. The macro appears in the Macros in 
Group box. Use the Move Up and Move Down buttons (on the right-hand side 
of the screen, labeled with arrows pointing up or down) to move the macro up 
or down in relation to the other macros.

5. Repeat step 4 until all the macros to be grouped appear in the Macros in Group box.

6. Click OK to accept the macro group and return to the Macros dialog box.
-or-
Click Cancel to leave this dialog box without saving changes.

To remove macros from an existing group:
1. Select Macros - Configure from the Viewer. The Macros dialog box appears.

2. Click Group. The Macro Groups dialog box appears.

3. Click the macro group tab to alter. Windows and Sun are the default tabs. If you 
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have created a new group, you will see a tab for this group as well. 

4. Click on the macro to remove from the Macros in Group pane on the right side 
of the dialog box. Click the Remove button. The macro appears in the Macros 
Available box. 

5. Repeat step 4 until all the macros to be removed appear in the Macros Available box.

6. Click OK to accept the macro group and return to the Macros dialog box.
-or-
Click Cancel to leave this dialog box without saving changes.

3.7 Changing ServSelect IP Software Server Properties
You can alter server properties from the ServSelect IP Software Explorer Properties 
dialog box including General, Network, Information and Connections. The General 
tab allows you to change the server name, server type and the icon that will be used 
to display the server in ServSelect IP Software. You may also assign the server to a 
site, location or folder. The Network tab lets you set a browser URL for that server if 
you want to view it in a browser window instead of through a session Viewer. The 
Information tab allows you to enter information about the server including a server 
description, contact information and any comments you would like to add. Lastly, 
the Connections tab displays the connection that will be used for a specific server. 

NOTE: 
You can also change the properties of your appliance. For more information, see Chapter 4.

To change server properties:
1. Select an individual server in the Unit Selector list.

2. Select View - Properties from the ServSelect IP Software Explorer menu.
-or-
Click the Properties task button. The Properties dialog box appears.

Figure 3-16. Server General Properties Tab
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3. Type in the name of the server. A warning will display if you enter a duplicate name. 

4. (Optional) Select the server type. If the selection is not in the pulldown, type 
the name of the new server type in the text field. Once entered, the option 
becomes available in the pulldown for future assignment.

5. (Optional) Select the icon to display for the unit.

6. (Optional) Assign a server to a site, department or location. (These categories are 
customizable. See Modifying custom field names in this chapter.) If an option is 
not in the pulldown, type the name of the new assignment in the text field. Once 
entered, the option becomes available in the pulldown for future assignment.

7. (Optional) Click the Network tab and type in the URL to use when establishing 
a browser connection to the server. If the field contains a value, then the 
Browser button appears in the task bar allowing you to launch the browser to 
that specified URL.

Figure 3-17. Server Network Properties Tab

8. (Optional) Click the Information tab and type in a description of the unit. There 
are no rules for the type of information that you may enter here. 

Figure 3-18. Server Information Tab
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9. (Optional) Click the Connections tab to view the physical connection path that will 
be used to access this server. This feature is useful for troubleshooting. Figure 3-19 
shows a connection to a server. Figure 3-20 shows a server connected to 
Channel 1 of a legacy switch.

    
Figure 3-19. Server Connection  Figure 3-20: Switch Connection 

10. When finished, click OK to save the new settings.
-or-
Click Cancel to exit without saving the new settings.

Accessing a server via a browser window
You can configure your system to open a server connection in a browser window. You 
must first select a server and define a URL in the Properties dialog box. Then, when 
you select the server, the Browse task button appears. You can select the browser to 
use in the ServSelect IP Software Explorer’s Options dialog box. 

To launch the server URL in a browser window: 
1. Select a server in the Unit Selector pane. 

2. If you have defined a URL for this server in the Properties dialog box, the 
Browse task button appears. Click the Browse task button. The URL you 
identified will launch in a browser window.



26

SERVSELECT™ IP SOFTWARE INSTALLER/USER GUIDE

27

 CHAPTER 3: BASIC OPERATIONS 

3.8 Organizing Units with the Local Client Database
The local client database provides persistent storage for unit names, properties, 
network addresses and custom session settings. Server attributes such as type, site and 
department allow you to create and store logical groups for your servers. Custom 
folders allow you to group units within the local client database. View tabs, sort bars 
and search functions use these attributes to find specific units within the database. 

Site organization is based on where your servers are located and refers to the column 
headings Site and Department, which can be customized to suit your needs. See 
Modifying custom field names in this chapter. Folders provide a way to create a 
customized organizational system for individual servers. For example, you might want to 
create a folder for critical servers or for remote servers. 

You may change the order and sorting of the Unit Selector list by clicking the sort bar 
above the column. An upward-pointing arrow in a column header indicates that the list 
is sorted by that field name in ascending order. A downward-pointing arrow indicates 
the list is sorted by that field name in descending order.

The sort bar properties are customizable. Figures 3.21 and 3.22 show examples of how 
you might use the default field name values. You may change them to fit your own 
organization. Figure 3-23 features customized field names.

Figure 3-21. Sites View Tab Selected
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Figure 3-22. Folders View Tab Selected

Modifying custom field names
Custom field names allow you to change the Site, Department and Location column 
heading names that appear in the Group and Unit Selector panes. This allows you to 
group appliances and servers in ways that are meaningful to you. The Department 
field is a subset of Site. If you customize these field names, you should keep this 
hierarchy in mind. 

Figure 3-23. Example of Modified Custom Fields

To modify a custom field label:
1. Select Tools - Options from the ServSelect IP Software Explorer menu. The 

Options dialog box appears. 
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Figure 3-24. Options Dialog Box - Custom Field Labels

2. Select a field label to modify and click the Modify button. The Modify Custom 
Field Label dialog box appears.

3. Type the singular and plural versions of the field label. The length can be from 
1 to 32 characters. A blank value is not allowed. Spaces are permitted in the 
middle but leading and trailing spaces are not allowed. 

4. Click OK to save the new field label.
-or-
Click Cancel to exit without saving changes.

Creating new sites, departments, locations or folders
You can organize units within your local database into sites, departments locations 
or folders by assigning a unit to that structure. Sites, departments and locations all 
appear under the Sites tab. These default headings can be changed. See Modifying 
custom field names in this chapter. Folders appear under the Folders tab and provide 
as many organizational options as you can imagine folder names. 

To create a new site, department or location:
1. Select View - Properties from the ServSelect IP Software Explorer menu. 

-or-
Click the Properties task button. The Properties dialog box appears.

2. Click the General tab and select the pulldown menu for Site, Department or 
Location. If a name is not in the pulldown menu, type the name you want in the 
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text field. The name can be from 1 to 32 characters long. Names are not case 
sensitive and can consist of any combination of characters entered from the 
keyboard. Spaces are permitted in the middle but leading and trailing spaces are 
not allowed. Duplicate names are not allowed. 

3. Click OK. The new site, department or location appears in the Group Selector pane.

To create a new folder:
1. Select the Folders View tab. 

2. Click on the top-level Folders node and select File - New - Folder. 
-or-
Right-click on the Folders node and select New Folder. The New Folder dialog 
box appears.
-or
Click on an existing folder and select File - New - Folder to create a nested folder.

3. Type in a name for the folder from 1 to 32 characters long. Folder names are 
not case sensitive and can consist of any combination of characters entered 
from the keyboard. Spaces are permitted in the middle but leading and trailing 
spaces are not allowed. Duplicate folder names are not allowed at the same 
level but are allowed across different levels. 

4. Click OK. The new folder appears in the Group Selector pane.

Assigning a unit to a site, location or folder
Once you have created a new site, location or folder, you can assign an appliance or 
server to that category. The Assign menu item is only enabled when a single 
appliance or server is selected in the Unit Selector pane. These custom targets are 
defined in the General Properties dialog box. 

To assign a unit to a site, location or folder: 
1. Select a unit in the Unit Selector pane. 

2. Select Edit - Assign from the ServSelect IP Software Explorer menu.
-or-
Click the Assign To task button. 
-or
Right-click on a unit and select Assign To. The Assign To dialog box appears.
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Figure 3-25. Assign To Dialog Box

3. Select the site, location or folder category from the pulldown menu. 

4. Select the target from the list of available targets to which the unit can be 
assigned within the chosen category. This could be empty if no site, location or 
folder has been defined in the local database.

5. Click OK to save the assignment.
-or-
Click Cancel to exit without saving changes.

To drag and drop a unit into a site, location or folder:
Click and hold on a unit in the Unit list. Drag the item on top of a folder icon (node) 
in the tree view of the Group Selector pane. Release the mouse button. The item now 
appears in the Unit list when you click that node. 

NOTE: 
A unit cannot be moved to All Departments, All Units or the root Sites node. Units can only be 
moved one at a time.

3.9 Deleting and Renaming 
The delete function works based on what is currently selected in the Group and Unit 
Selector panes. When you select and delete a unit in the Unit list, the unit is removed 
from the local database. This will not affect the configurations in the OSD. When 
you select and delete an item in the tree view of the Group Selector pane, you will 
delete Server Types, Sites, Departments or Folders; however, none of the actions 
result in units being deleted from the local database. 

The rename function is also dependant on what is currently selected. You can select and 
rename an appliance or a server from the Unit list. You can select and rename server 
types, sites, departments and folder names in the tree view of the Group Selector pane.

NOTE:
If you delete or rename a server through the ServSelect IP Software, the OSD server list at the local 
analog station becomes outdated. Resynching won’t download server names into the OSD. Servers 
should be deleted or renamed from the OSD and then resynchronized in ServSelect IP Software.
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To delete an appliance or server:
1. Select the unit(s) to delete from the Unit Selector pane.

2. Select Edit - Delete.
-or-
Press the Delete key on your keyboard. A dialog box appears confirming the 
number of units to be deleted. If you are deleting an appliance, the dialog box 
includes a Delete Associated Servers checkbox. Enable/disable the checkbox 
as desired.

3. Click Yes to confirm the deletion. Additional message prompts may appear depending 
on your configuration. Respond as appropriate. The appliance or server is deleted.
-or-
Click No to cancel.

To delete a server type, site, department or folder:
1. Select the server type, site, department or folder to delete from the Group 

Selector pane.

2. Select Edit - Delete.
-or-
Press the Delete key on your keyboard. A dialog box appears confirming the 
number of units that will be affected by this deletion. 

3. Click Yes to confirm the deletion. Additional message prompts may appear 
depending on your configuration. Respond as appropriate. The element is deleted.
-or-
Click No to cancel.

To rename a server type, site, department or folder:
1. In the Group Selector pane, click on the server type, site, department or folder 

to rename.

2. Select Edit - Rename. The Rename dialog box appears.

3. Type in a name from 1 to 32 characters long. Names can consist of any combination 
of characters. Spaces are permitted in the middle but leading and trailing spaces are 
not allowed. Duplicate names are not allowed, including the same name with 
different cases, with two exceptions: department names can be duplicated across 
different sites and folder names can be duplicated across different levels.

4. Click OK to save the new name.
-or-
Click Cancel to exit without saving changes.
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3.10 Customizing the Explorer Window
The ServSelect IP Software Explorer window can be resized at any time. Each time 
you launch the application, the ServSelect IP Software Explorer window opens to its 
default size and location. 

A split-pane divider that runs from top to bottom separates the Group Selector pane and 
the Unit Selector pane. You can move the divider left and right to change the viewing 
area of the Group Selector pane and the Unit Selector pane. Each time ServSelect IP 
Software Explorer is started, the divider will appear in its default location. See Appendix B 
for mouse and keyboard shortcuts that control the divider, panes and tree view.

Modifying the selected view on startup
When Default is checked under the selected view on the startup option, the 
ServSelect IP Software Explorer will determine which view to display. If you have 
one or more servers defined, the Servers display will appear by default. If you do 
not, the Appliances display will appear. 

When Default is unchecked, the ServSelect IP Software Explorer will display the 
view selected in the pulldown menu shown below the checkbox. The pulldown 
menu contains the following values: Appliances, Servers, Sites and Folders. The 
pulldown menu is only enabled when the checkbox is unchecked.

To modify the selected view on startup:
1. Select Tools - Options from the ServSelect IP Software Explorer menu. The 

Options dialog box appears. 

2. Select Appliances, Servers, Sites or Folders from the pulldown menu.

3. Click OK to save the new startup view.
-or-
Click Cancel to exit without saving changes.

Changing the default browser
You can specify which browser launches when viewing a server URL in a browser 
window. You have the option of using the default browser for your system, or you 
can select a specific browser to launch for that server. 

To change the default browser:
1. Select Tools - Options from ServSelect IP Software Explorer. The Options 

dialog box appears. 

2. Deselect the Launch Default Browser checkbox. The Browse button is enabled.
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3. Click the Browse button and navigate to the browser.

4. Click OK to save the new browser selection.
-or-
Click Cancel to exit without saving changes.

3.11 Managing Your Local Databases
Each workstation running ServSelect IP Software contains a local database that 
records the information that you enter about your units. If you have multiple 
workstations, you may configure one station and then save a copy of this database 
and load it into the other stations to avoid unnecessarily reconfiguring each station. 
You may also export the database for use in another application. 

Saving a database
ServSelect IP Software allows you to save a copy of the local database for later use. 
The saved database can then be loaded back to the same computer where it was 
created, or it can be loaded onto another ServSelect IP Software client. The saved 
database is compressed into a single Zip file. 

While the database is being saved, no other activity is allowed. All other windows 
including Video Session windows and AMP windows must be closed. If other 
windows are open, a message will appear prompting you to either continue and close 
all open windows or quit and cancel the database save process. 

To save a database:
1. Select File - Database - Save. The Database Save dialog box appears. 

Figure 3-26. Database Save Dialog Box

2. Type in a file name and choose a location to save the file.

3. Click Save. A progress bar appears. When finished, a message appears indicating 
that the save was successful and you are returned to the main window.
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Exporting a database
This function allows you to export fields from the local database to an ASCII 
Comma Separated Value file (CSV) or Tab Separated Value file (TSV). The 
following database fields will be exported. 

Exported Database Fields 

ServSelect IP Flag
Type
Name
Address 
Custom Field 1
Custom Field 2
Custom Field 3
Description
Contact Name
Contact Phone #
Comments
Browser URL

NOTE: 
The Address field only applies to appliances and the Browser URL field only applies to servers. In 
the exported file, the Address field data will be empty for servers and the Browser URL field data 
will be empty for appliances.

The first line of the exported file contains the column names for the field data. Each 
additional line contains the field data for an appliance or server. The file will contain 
one line for each appliance and server defined in the local database. 

To export a database:
1. Select File - Database - Export from the ServSelect IP Software Explorer 

menu. The Database Export dialog box appears.

2. Select a database to export. 

3. Type in a file name and browse to the location to save the exported file.

4. Click Export. A progress bar appears during the export. When it’s finished, a 
message appears indicating that the export was successful and you are returned 
to the main window.

Loading a database
This function allows you to load a database that was previously saved. While the 
database is being loaded, no other activity is allowed. All other windows including 
Video Session windows and AMP windows must be closed. If other windows are open, 
a message appears prompting you to either continue and close all open windows or quit 
and cancel the database save process. 
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To load a database:
1. Select File - Database - Load from the ServSelect IP Software Explorer menu. 

The Database Load dialog box appears. 

2. Browse to select a database to load. 

3. Click Load. A progress bar appears. When finished, a message appears indicating 
that the load was successful and you are returned to the main window.

3.12 Changing Appliance Properties
You can alter individual appliance properties whether you are logged into the 
ServSelect IP or not. The Properties dialog box contains several tabs: General, 
Network and Information. The General tab allows you not only to change the name 
and display icon for an appliance, but also to assign the ServSelect IP to a site, location 
or department. The Network tab allows you to establish an IP address for that 
ServSelect IP. The Information tab allows you to enter information about the appliance 
including a description, contact information and any comments you would like to add. 

To change appliance properties:
1. Select an individual appliance in the Unit Selector list.

2. Select View - Properties from the ServSelect IP Software Explorer menu bar.
-or-
Click the Properties button. 
-or-
Right-click on the switch and select Properties from the pop-up list. The 
Properties dialog box appears.

Figure 3-27. Appliance General Properties
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3. Type in the name of the appliance. A warning displays if you enter a duplicate name. 

4. Skip the Type field. This is read-only for appliances. 

5. Select the icon to display for the unit.

6. (Optional) Select the site, department and location to which you would like the 
appliance assigned. If a selection is not in the pulldown, type the name of the new 
assignment in the text field. Once entered, the option becomes available in the 
pulldown for future assignment.

7. Click the Network tab and type in the address of the appliance. This field can 
contain an IP dot notation or a domain name. Duplicate addresses are not allowed 
and the field cannot be left blank. You can enter up to 128 characters. 

8. (Optional) Click the Information tab and type in the description of the unit. You 
are free to enter any information into these fields.

9. When finished, click OK to save the new settings.
-or-
Click Cancel to exit without saving.

3.13 Changing DirectDraw® support
ServSelect IP Software supports DirectDraw, a Microsoft® protocol that allows 
direct manipulation of video display memory, hardware blitting, hardware overlays 
and page flipping without the intervention of the Graphical Device Interface (GDI). 
A GDI is a part of the graphical user interface that provides programmers with 
consistant style control. This can result in smoother animation and improvement in 
the performance of display-intensive software. 

However, if your machine has a software cursor or pointer shadow enabled, or if 
your video driver does not support DirectDraw, you may experience a flicker in your 
mouse cursor when it’s over the title bar of the Viewer. 

You can either disable the software cursor or pointer shadow, load a new driver for 
your video card or disable DirectDraw.
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Figure 3-28. Options Dialog Box - DirectDraw

To disable DirectDraw:
1.  Select Tools-Options. The Options dialog box appears.

2. Deselect the DirectDraw checkbox. 

3. Click OK.
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4. Managing Your Appliance (Admin Only)
Administrators can use the Appliance Management Panel (AMP) to manage and 
install the ServSelect IP. You may view and configure its parameters, view and 
control currently active video sessions and execute a variety of control functions 
such as rebooting and upgrading your appliance. 

Figure 4-1. AMP Dialog Box

To access the AMP:
1. Click the Appliances button in the ServSelect IP Software Explorer.

2. Double-click on an appliance from the Unit Selector pane.
-or-
Select an appliance from the Unit Selector pane, then click the Manage 
appliance task button.
-or-
Right-click on an appliance in the Unit Selector pane. A pop-up menu appears. 
Select Manage appliance.
-or-
Click an appliance in the Unit Selector pane and press Enter. 

3. A password prompt appears. Type in your username and password and click 
OK. The default username is Admin with no password.

NOTE: 
ServSelect IP Software caches your user credentials until the application is closed. You do not 
need to re-enter your credentials for each session.

4. The AMP dialog box appears.
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4.1 Viewing and Configuring Appliance Parameters
The Settings tab allows you to display an expandable list of categories covering a 
wide range of parameters for your appliance. When a category is selected from the 
list, the parameters associated with the category will first be read from the unit, the 
local database or both. You will then be able to modify those parameters and send 
the changes securely back to the appliance.

Changing global network and session parameters
The Global category allows you to view the product type, product code, serial number 
and language setting for the appliance. If you select the Network sub-category, you 
will be able to change the network settings including the IP address, subnet mask, 
gateway, LAN speed and BootP setting. If you select the Sessions sub-category, you 
can enable the session time-out to allow the appliance to close an inactive video 
session after a specified number of minutes.

Setting up user accounts
When you select the Users category for the first time, the AMP will retrieve and 
display a list of usernames and current access levels from the appliance. You can 
add, modify or delete users in this listing. You can assign three access levels: User, 
User Administrator and Appliance Administrator. Only accounts defined as the User 
access level can be assigned server access rights on an individual basis. 

User Access Level Rights

Operations Appliance Admin User Admin User

Preemption All Equal and lesser Equal and Lesser

Configure network & 
global settings (security 
mode, time-out, SNMP) Yes No No

Reboot Yes No No

FLASH upgrade Yes No No

Administer user accounts Yes Yes No

Configure port settings Yes Yes No

Monitor server status Yes Yes No

Break Yes Yes Yes

Target Server Access Yes Yes Assigned by Admin
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Figure 4-2. Users Dialog Box

To add or modify a user:
1. Click the Users category in the left column in the AMP.

2. Click the Add button on the right side of the window to add a new user. The 
Add User dialog box appears.
-or- 
Select a user and click the Modify button to modify a current user. The Modify 
User dialog box appears.

Figure 4-3. Add User Dialog Box

3. Enter the username and password to assign to the user and then verify the 
password by typing it into the Verify Password field.

4. Select the appropriate access level for this user from the pulldown menu. If you 
select the User option, the Access Rights button becomes selectable. 
a. Click the Access Rights button to select individual servers for that user. 

The User Access Rights dialog box appears.
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Figure 4-4. User Access Rights Dialog Box
b. Select a server in the left column for which this user should have access 

rights. Select the Add button.
c. Select a server in the right column from which to remove a user’s access 

rights. Click the Remove button.
d. Repeat steps a and b until the right column represents the appropriate 

server access for this user, and then click OK.
5. Click OK to save the settings and return to the main AMP window.

To delete a user:
1. Click the Users category in the left column in the AMP and then select the 

user(s) to delete.

2. Click the Delete button on the right side of the AMP Users window. A 
confirmation window appears. 

3. Click Yes to confirm the deletion.
-or-
Click No to exit the window without deleting the user.

Viewing the SAM adapters 
The SAMs category lets you view the SAM adapters in your system, their port and EID 
numbers as well as the computer type and keyboard language. You can also view the SAM 
status. A green circle indicates that the SAM is online. A yellow circle means the SAM is 
being upgraded and a red X indicates that the SAM is offline.

Enabling and configuring SNMP 
SNMP (Simple Network Management Protocol) is a protocol used to communicate 
management information between network management applications and appliances. 
Other SNMP managers (such as Tivoli and HP OpenView) can communicate with your 
appliance by accessing MIB-II (Management Information Base) and the public portion 
of the enterprise MIB. MIB-II is a standard MIB that many SNMP servers support. 
When you select the SNMP category for the first time, the AMP will retrieve the SNMP 
parameters from the unit. 
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In this dialog box, you can enter system information and community strings. You may 
also designate which stations can manage the appliance as well as receive SNMP traps 
from the switch. For more information on traps, see Enabling individual SNMP traps 
in this chapter. If you check Enable SNMP, the unit will respond to SNMP requests 
over UDP (User Datagram Protocol) port 161. Port 161 is the standard UDP port used 
to send and receive SNMP messages.

If you enter the IP addresses of one or more allowable managers, only those IP 
addresses will be able to manage the appliance via SNMP. If you do not enter any IP 
addresses, then the appliance can be managed via SNMP from any IP address.

NOTE: 
The AMP uses SNMP within a secure tunnel to manage appliances. For this reason, UDP Port 
161 need not be exposed on firewalls. You will need to expose UDP Port 161 to monitor Black Box 
appliance via third-party SNMP-based management software.

Figure 4-5. SNMP Configuration Dialog Box

To configure general SNMP settings:
1. Click the SNMP category in the left column in the AMP.

2. Click the Enable SNMP checkbox to allow the appliance to respond to SNMP 
requests over UDP port 161. 

3. Enter the system’s fully qualified domain name in the Name field, as well as a 
description and node contact person in the System section.

4. Enter the Read, Write and Trap community names. These specify the 
community strings that must be used in SNMP actions. The Read and Write 
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strings only apply to SNMP over UPD port 161 and act as passwords that 
protect access to the appliance. The values can be up to 64 characters in length.

5. Add up to four SNMP management entities to monitor this appliance or leave this 
blank to allow any station to monitor the appliance.
a. Click the Add button to define an allowable manager. The Allowable Man-

ager dialog box appears.
b. Type in the IP address of the management station to add.
c. Click OK to add a management station.

6. Add up to four SNMP trap destinations to which this appliance will send traps 
in the Trap Destination field.
a. Click the Add button to define a trap destination. The Trap Destination 

dialog box appears.
b. Type in the IP address of the trap destination to add.
c. Click OK to add a trap destination.

7. Click OK to save the settings and close the window.
-or-
Click Apply to save the settings and remain in the open window.
-or-
Click Cancel to exit the window without saving.

Enabling individual SNMP traps
An SNMP trap is a notification sent by the appliance to a management station 
indicating that an event has occurred in the appliance that may require further 
attention. You can specify what SNMP traps are sent to the management stations by 
simply clicking the appropriate checkboxes in the list. When you select the Traps 
category for the first time, the AMP will retrieve and display a list of SNMP traps 
from the appliance. You may select Enable All or Disable All to easily select or 
deselect the entire list.
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Figure 4-6. Traps Dialog Box

Viewing server connections
When you select the Servers category for the first time, the AMP will retrieve the 
servers that exist in the ServSelect IP Software database as well as information on 
how the servers are connected to the selected appliance. 

The Connection column displays the current server connection. This can be to either a 
SAM adapter or a ServSwitch Multi Z8. If the ServSelect IP is connected to a SAM 
adapter, the SAM’s EID will display in the Connection column. If the ServSwitch IP is 
connected to a Z8, the Z8 and all of its channels will be displayed. If no unit is 
currently connected to the path, then this field will display as None. If you click either 
a SAM or Z8 in the Connection column, the Viewer will launch. 
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Figure 4-7. Servers Dialog Box

Resynchronizing the server listing
You may choose to periodically resynchronize the database on your ServSelect IP Software 
client with the database stored in the appliance. Do this if the local analog workstation has 
changed server names or if SAM adapters have been added or moved.

NOTE: 
This procedure only resynchronizes your own ServSelect IP Software client. If you have multiple 
ServSelect IP Software clients, save your resynchronized local database and load it into the other 
ServSelect IP Software clients to ensure consistency.

To resynchronize the server listing:
1.  Click the Resync button in the Server category of the AMP. The Resync Wizard 

launches. Click Next.

2. A warning message displays indicating that the database will be updated to 
match the current configuration in the appliance. Your current local database 
names will be overridden with the appliance names. Click Next.

3. A polling appliance message box appears with a progress bar indicating that the 
appliance information is being retrieved.

4. If no changes were detected in the appliance, a completion dialog box appears 
with this information. Click Finish to exit.
-or-
If changes were detected in the appliance, the Detected Changes dialog box 
appears. Click Next. 
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a. If a ServSwitch Multi Z8 was detected, the Enter Cascade Switch Infor-
mation dialog box appears. For more information, see Viewing cascade 
switch connections in this chapter.

 -or-
If no cascade switch was detected, then the Detected Changes dialog box 
will be displayed. 

b. Click Next to update the database.
c. When the update is finished, a completion dialog box appears. Click 

Finish to exit.

Viewing cascade switch connections
The Cascade Switches category lets you view the cascade switches in your system 
and the SAM adapter EID numbers, as well as the port to which it is connected. At 
the time of this writing, the KV158A 2 x 8 ServSwitch Multi Z8 is the only available 
cascade switch; do not attempt to select or add other switch types.

Figure 4-8. Configure Cascade Switches Dialog Box
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4.2 Upgrading Firmware
You can upgrade the firmware for either the appliance or the SAM adapters. The 
SAM adapters can be upgraded individually or simultaneously. When an upgrade is 
initiated, a message will display the current status. As long as an upgrade is in 
progress, you cannot initiate another.

Viewing appliance Version information
When you select the Version category for the first time, the AMP will retrieve the 
firmware versions from the selected appliance. The Hardware sub-category displays 
the version information for the unit itself. The SAMs sub-category allows you to view 
and upgrade all of the SAM adapters in the system. 

Figure 4-9. Firmware Version Dialog Box

To upgrade appliance firmware:
1. Click the Tools tab in the AMP. The Tools dialog box appears. 

2. Click the Upgrade ServSelect IP Firmware button. The Firmware Upgrade dialog 
box appears. Type in the TFTP (Trivial File Transfer Protocol) server IP address 
where the firmware is located as well as the firmware filename (the full pathname).

Figure 4-10. Upgrade Firmware Dialog Box
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3. Click the Upgrade button. The Upgrade button dims and a progress message appears.

4. When the upgrade is complete, a message appears, prompting you to confirm a 
reboot. The new firmware will not be used until the switch reboots. Click Yes to 
reboot the appliance. The Upgrade Firmware dialog box will display a progress 
message including a message that the reboot is complete. 
-or-
Click No to reboot at a later time. You must reboot to use the new firmware.

5. Click Close to exit the Upgrade Firmware window.

CAUTION: 
Do not turn off the ServSelect IP while it is rebooting. We recommend that you keep the 
ServSelect IP on an uninterruptible power supply; if it loses power while rebooting with new 
firmware, you might need to return it.

To simultaneously upgrade multiple SAM adapters:
1. Click the Tools tab in the AMP. The Tools dialog box appears. 

2. Click the Upgrade SAM Firmware button. The Upgrade SAM Firmware dialog 
box appears. 

3. Click the checkboxes in front of each type of SAM adapter to upgrade.

4. Click Upgrade. The Upgrade button dims. The Status column will display 
either In Progress or Succeeded, depending on the status of each SAM upgrade. 
A Firmware upgrade currently in progress message displays until all of the 
selected SAM adapter types are upgraded.

5. When complete, a message appears prompting you to confirm the upgrade 
completion. Once confirmed, the Upgrade button is again enabled. 

6. Click Close to exit the Upgrade Firmware window.

To upgrade SAM firmware individually:
1. Click the Settings tab in the AMP. 

2. Click the SAM sub-category under Versions in the left column in the AMP.

3. Select the EID pulldown menu and choose the SAM adapter for which you 
would like to view firmware information. The IDs displayed in the pulldown 
are a combination of the EID and either the server name or switch name, 
depending on what is attached to the SAM adapter. If the SAM is not attached 
to anything, the pulldown will display None. Once selected, the firmware 
information appears in the Information box.

(continued on the next page)
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4. Compare it to the Firmware Available box to see the firmware upgrade 
available to the SAM adapter. If the SAM adapter requires upgrading, click the 
Load Firmware button.

5. The firmware upgrade begins. During the upgrade, a progress message displays 
below the Firmware Available box and the Load Firmware button dims. When the 
upgrade is finished, a message appears indicating that the upgrade was successful. 

6. Repeat steps 2-5 for each SAM to upgrade. 

7. When you’re finished, click OK.

4.3 Managing User Sessions
You may view and disconnect the current active user connections using the Status tab in 
the AMP. You can view the length of time the users have been connected, the server name 
or SAM to which they are connected and their system address.

Figure 4-11. User Status Dialog Box

To disconnect a user session:
1. Click the Status tab in the AMP. The User Status dialog box appears. 

2. Click one or more users to disconnect.

3. Click the Disconnect Session button. A message appears prompting you to 
confirm the disconnect command. 

4. Click Yes to disconnect the user.
-or-
Click No to exit without completing the disconnect command.
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4.4 Rebooting Your Appliance
You can reboot the ServSelect IP through the Tools tab in the AMP. When clicked, 
Reboot will broadcast a disconnect message to any active users, then log out the 
current users and immediately reboot the appliance. 

To reboot your appliance:
1. Click the Tools tab in the AMP. The Tools dialog box appears. 

2. Click the Reboot button. A message prompting you to confirm this reboot 
appears. Click Yes to confirm the request. The appliance will now reboot.

4.5 Managing Appliance Configuration Databases
An on-board database contains all of the settings for an appliance. This includes 
network settings, SAM configurations, SNMP settings and attached servers. You may 
save this configuration information to a client-based file and, should you ever need to 
replace your ServSelect IP, restore the configuration file to the new appliance and 
avoid manually configuring it.

NOTE: 
User account information is stored in the user database, not in the configuration file. For more 
information, see Managing User Databases in this chapter.

To read and save a configuration to a file from an appliance:
1. Click the Tools tab in the AMP. The Tools dialog box appears. 

2. Click the Save Appliance Configuration button. The Save Appliance 
Configuration dialog box appears. 

3. Click Browse and navigate to a location to save the Configuration file. The 
location appears in the Save To field.

4. Click Save. The configuration file is read from the appliance and saved to the 
desired location. A progress window displays. 

5. When complete, a message appears prompting you to confirm the read 
completion. Click OK to return to the main window.

To restore a configuration file to an appliance:
1. Click the Tools tab in the AMP. The Tools dialog box appears. 

2. Click the Restore Appliance Configuration button. The Restore Appliance 
Configuration File dialog box appears. 

3. Click Browse and navigate to the location where you stored the saved 
configuration file. The file name and location appears in the File name field.
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4. Click Restore. The configuration file is written to the appliance. A progress 
window displays. 

5. When complete, a message appears prompting you to confirm the write 
completion. Click OK to return to the main window.

4.6 Managing User Databases
An on-board user database contains all the user accounts and access rights assigned in 
an appliance. You can save this database to a client-based file and use it to configure 
users on other appliances by loading the user account file into the other appliances.

NOTE: 
The user account file is encrypted and you will be prompted to create a password when you save the 
file. You will need to enter this password when you write the file to a new unit.

To save a user database from an appliance:
1. Click the Tools tab in the AMP. The Tools dialog box appears. 

2. Click the Save Appliance User Database button. The Save Appliance User 
Database dialog box appears. 

3. Click Browse and navigate to a location to save the user database file. The 
location appears in the Save To field.

4. Click Save. The user database file is read from the appliance and saved to a 
location. A progress window displays. 

5. When complete, a message appears prompting you to confirm the read 
completion. Once confirmed, the Save Appliance User Database dialog box will 
close and you are returned to the Tools window.

To load a user database file into an appliance:
1. Click the Tools tab in the AMP. The Tools dialog box appears. 

2. Click the Restore Appliance User Database button. The Restore Appliance 
User Database dialog box appears. 

3. Click Browse and navigate to the location where you stored the saved user 
database file. The file name and location appears in the File name field.

4. Click Restore. The user database file is written to the appliance. A progress 
window displays. 

5. When complete, a message appears prompting you to confirm the write 
completion. Once confirmed, the Restore Appliance User Database dialog box 
will close and you are returned to the Tools window.
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Appendices

Appendix A: Updating ServSelect IP Software
For optimal performance, ensure that you have the latest version of ServSelect IP 
Software available from the Black Box web site.

To update ServSelect IP Software:
1. Contact Black Box technical support and follow their instructions for 

downloading the update file.

2. Double-click on the installer. The installer will check to see if a previous 
version of ServSelect IP Software resides on your system. 

3. If no previous version has been detected and a dialog box appears to confirm 
the upgrade, click Continue.
-or-
If a previous version is detected and a dialog box appears alerting you to 
another version of the product, click Overwrite to confirm the upgrade.
-or-
Click Cancel to exit without upgrading the software.

4. Installation begins. The Program Files, Shortcuts, Environment Variables and 
the Registry Entries (on 32-bit Windows systems), will be installed or will be 
overwritten with the new files and settings of the current version.

NOTE: 
In order for the upgrade detection process to work, you must first either reboot or log out. 
Environment Variables set by the installer are not permanent on 32-bit Windows platforms or 
Linux until you have logged out or rebooted the system.
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Appendix B: Keyboard and Mouse Shortcuts

Keyboard and Mouse Shortcuts for the Divider and Panes
Operation Description

F6 Navigates between the screen panes and activates the 
element in each pane that was active when the pane was 
previously selected.

F8 Selects and activates the divider.

Left or Up Arrow Moves the divider left if the divider is active.

Right or Down Arrow Moves the divider right if the divider is active.

Home Gives the screen’s right-hand pane all of the screen area 
(the left-hand pane disappears) if the divider is active.

End Gives the screen’s left-hand pane all of the screen area 
(the right-hand pane disappears) if the divider is active.

Click +Mouse Drag Moves the divider left or right.

Keyboard and Mouse Shortcuts for Tree-View Control
Operation Description

Mouse Single-Click Deselects the currently active node (folder, appliance, 
group, etc. icon) and selects the node that the mouse 
pointer is on..

Mouse Double-Click Alternately expands and collapses nodes that contain 
other nodes. Has no effect on nodes that don’t contain 
other nodes.

Up Arrow Deselects the currently active node and selects the node 
above it.

Down Arrow Deselects the currently active node and selects the node 
below it.

Spacebar Alternately selects and deselects the currently active node.

Enter Alternately expands and collapses the currently active 
node if it contains other nodes. Has no effect if the node 
doesn’t contain other nodes.

Home Deselects the currently active node and selects the root node.

End Deselects the currently active node and selects the last 
node displayed in the tree.
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Keyboard and Mouse Operations for the Unit List
Operation Description

Enter or Return Launches the default action for the selected unit.

Up Arrow Deselects any currently selected units and selects the unit 
in the row above the topmost previously selected unit.

Down Arrow Deselects any currently selected units and selects the unit 
in the row below the bottommost previously selected unit.

Page Up Deselects any currently selected units and scrolls up 
one page from the topmost previously selected unit, then 
selects the first unit on the page.

Page Down Deselects any currently selected units and scrolls down 
one page from the bottommost previously selected unit, 
then selects the last unit on the page.

Delete Performs the Delete function. Works the same as the 
Edit>Delete menu function.

Ctrl +Home Deselects any currently selected units and selects the unit 
in the first row of the table.

Ctrl +End Deselects any currently selected units and selects the unit 
in the last row of the table.

Shift +Up Arrow In addition to any previously selected units, selects the unit 
in the row above the topmost of those units.

Shift +Down Arrow In addition to any previously selected units, selects the unit 
in the row below the bottommost of those units.

Shift +Page Up In addition to any previously selected units, selects all of 
the units in the page above the topmost of those units.

Shift +Page Down In addition to any previously selected units, selects all of 
the units in the page below the bottommost of those units.

Shift +Mouse Click Deselects any currently selected units and selects all of 
the units in the rows between the previously selected 
unit(s) and the row that the mouse pointer is on when the 
mouse is clicked.

Ctrl +Mouse Click Alternately selects and deselects the unit in the row that 
the mouse pointer is on without selecting or deselecting 
any other units.

Mouse Double-Click Launches the default action for the selected unit.
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Appendix C: TCP Ports
The Video Session Viewer communicates with the KV120/121A over TCP ports 
8192 and 2068. Digitized video data is sent over port 8192. Encrypted keyboard and 
mouse data is sent over port 2068. The AMP communications with the KV120/121A 
over TCP port 3211. All data on ports 2068 and 3211 is encrypted using the Secure 
Socket Layer (SSL) protocol.

The KV120/121A retains the database of user accounts and permissions. The Video 
Session Viewer performs user authentication over encrypted port 2068. The AMP 
performs user authentication over encrypted port 3211.

ServSelect IP

Digital User

ServSelect IP
Software

TCP/IP
Ports 8192, 3211

and 2068

Figure C.1. TCP Port Communication
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Appendix D: Troubleshooting
Adjusting the video quality
The Video Viewer offers both automatic and manual video adjustment capability. 
Generally, the Automatic Video Adjustment will optimize the video for the best possible 
view. However, you may fine tune the video with the aid of Black Box technical support. 

Dialog Box Options for Manual Video Adjustment

A

I

B C D E F G H

J
K

L

M

N

O

Figure D.1. Dialog Box for Manual Video Adjustment

A. Image Capture Width button I. Automatic Video Adjustment button

B. Image Capture Height button J. Refresh Image button

C. Image Capture Horizontal Position button K. Adjustment bar 

D. Image Capture Vertical Position button L. Video Test Pattern button

E. Contrast button M. Help button

F. Brightness button N. Performance Monitor area

G. Noise Threshold button O. Close box

H. Priority Threshold button 

To manually adjust the video quality of the Video Viewer window:
1. Select Tools - Manual Video Adjust. The Manual Video Adjust dialog box appears.

2. Click the icon for a feature to adjust. 

3. Move the slider bar and then fine tune the setting by clicking the Minus (-) or 
Plus (+) buttons to adjust the parameter for each icon pressed. The adjustments 
will display immediately in the Video Viewer window.

4. When finished, click Close to exit the Manual Video Adjust dialog box.
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